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1 Introducciod

1.1 Proposit del projecte

El seglient projecte s’emmarca dins els estudis d'enginyeria informatica de la Universitat
Oberta de Catalunya. S'engloba dins de l'area d'aplicacions web pel treball col-laboratiu 1
concretament en 1'ambit de les aplicacions web per a entorns de e-learning.

Com a proposit general el projecte pretén estudiar, analitzar 1 dissenyar una arquitectura
de software web existent evolucionant-la permeten l'accés 1 interacci6 des del nou
paradigma dels dispositius mobils

Els dispositius mobils tenen moltes limitacions a nivell de computacio, memoria,
visualitzaci6 de dades, etc... Per aix0 quan es pensa en fer accessible una aplicacié web
des d'aquests entorns cal redissenyar o adaptar l'aplicacid per aquests nous clients,
arribant fins i tot a dissenyar una capa especifica per sobre l'aplicaci6 que faci de pont
entre els dos mons.

Concretament pretenem proporcionar l'accés a l'entorn d'aprenentatge virtual moodle des
de dispositius mobils. Aixi com dotar a la plataforma mobil de capacitat per gestionar les
notificacions i alertes de l'activitat de I'entorn. Per fer-ho ens caldra també pensar en
proporcionar els mecanismes adequats en totes les capes.

A nivell més técnic ens centrarem en la part de middleware necessaria en l'aplicacidé web

per tal que permeti connectar-nos correctament des d'un dispositiu mobil.



2 Descripcio del projecte

2.1 Objectius del projecte

2.1.1 Objectius generals

Com en qualsevol projecte de final de carrera I’objectiu més general és el de consolidar
els coneixements adquirits durant els estudis. Essent capac¢ de realitzar la planificacio,

disseny, implementacid, documentacio i defensa d’un projecte complet.

A nivell funcional 1'objectiu d'aquest projectes es adaptar una aplicaci6 web per a

l'explotacié mitjangant dispositius mobils.

2.1.2 Objectius técnics

A nivell técnic I'objectiu del projecte es proporcionar un middleware o un conjunt de
llibreries a través de la qual una aplicacid web d'aprenentatge virtual pugui ser explotada
via dispositius mobils. També caldra fer una gestido ampliada de les notificacions i

alarmes del sistema.

2.1.3 Objectius personals

Ser capag de crear 1 presentar treballs amb idees propies 1 argumentades.

Madurar 1 preparar-se pel mén empresarial 1 I’exigeéncia de les empreses.

Ser capag d’aprendre i1 investigar pel meu compte

Tenir voluntat i capacitat organitzativa per planificar les tasques i I’esfor¢ de forma
realista i adequada, aixi com ser capa¢ de complir aquesta planificacio.

Agafar confianga en les propies capacitats i prendre consciéncia de la nova etapa que

s’inicia despres d’acabar els estudis.

2.2 Motivacions

En el context actual de crisi 1 globalitzacié la formacio esdevé clau per a afrontar nous
reptes 1 seguir en el mercat laboral.

Aquest projecte pretén dotar d'una nova forma d'aprenentatge mitjancant els dispositius
mobils i per tant contribuir de forma modesta a millorar les possibilitats dels usuaris de

sobreviure 1 millorar en aquests moments dificils.



D'altra banda la tecnologia de dispositius mobils és el paradigma de programacié del
futur 1 per tant tot projecte que permeti avangar en aquesta linia es positiu per fer créixer
el mercat de les aplicacions de client lleuger.

Finalment a nivell d'oportunitat de mercat la formacid és un mercat que en el context
actual esta creixent i on es generen noves oportunitats cada dia. Crear un producte
competitiu a nivell m-learning pot ser una bona oportunitat per a la universitat i per mi

mateix.

A nivell personal la motivaciéo més gran és consolidar els meus coneixements adquirits
durant els meus estudis i poder també conéixer a fons l'arquitectura client servidor en

aquest nou paradigma dels dispositius mobils.

2.3 Resultats esperats
A banda del procés d'estudi i realitzaci6 del projecte com a fi en si mateix, s'espera

obtenir d'aquest projecte els segiients tangibles:

* Analisi de la capa de comunicacié de Moodle .

* Analisi dels factors claus per a la interacci6 de serveis web 1 aplicacions mobils.

* Analisi i disseny del middleware i modificacions necessaries per a I'explotacio de
l'entorn virtual d'aprenentatge des d'aplicacions mobils.

*  Documentacio d'especificacié del middleware.

* Memoria del projecte.

2.4 Altres consideracions

Un fet important sobre el projecte és esta dividit en dues parts i el realitzem conjuntament
amb una alumne que ha escollit el mateix ambit tematic.

Jo m'encarrego del disseny del middleware necessari a la capa servidor per al correcte
funcionament de l'aplicacié en entorns mobils tant pel que fa a comunicacié com a
presentacio.

L'altre part del projecte s'encarrega de 1'analisi i el disseny de 1'aplicacié mobil en si
mateixa aixi com de la gestid general de notificacions i alertes.

Aixi doncs la dependeéncia dels dos projectes és clara i en algun moment del projecte

podrem fer puntualment referéncia a l'altra part del projecte.
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3 Planificacio i fites destacades

3.1 Planificacio

La planificacio del projecte ve marcada principalment per les entregues estructurades a
l'aula de projecte. Malgrat tot per tenir un control més exhaustiu de I'avang del projecte
presentem un diagrama de gantt on es poden visualitzar les tasques del projecte

agrupades per fases i els diferents punts d'entrega o PAC's (rombes vermells)
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3.2 Fites destacades
A continuacio6 presentem en una taula resum les tasques principals, temporitzacio i fites
destacades del desenvolupament que hem dut a terme.

Tasca Data Inici Data Fi Duracio (dies)

Fase Previa
Seleccio del treball 21/09/11 24/09/11 4
Analisi Preliminar per determinar abast 25/09/11 04/10/11 10
pla de treball ( PAC1) 01/10/11 17/10/11 16
PACI 17/10/11

Analisi
Instal-laci6 e-learning i eines 08/10/11 10/10/11
Analisi capa comunicacié 11/10/11 13/10/11

Analisi factors clau web-mobil 13/10/11 16/10/11



Analisi notificacions i alarmes 18/10/11 21/10/11 3

Tancament funcionalitats 21/10/11 22/10/11 1
Disseny

Disseny gestio Notificacions 23/10/11 27/10/11 5

Disseny middleware mobil 27/10/11 06/11/11 10

Especificacio del middleware 05/11/11 12/11/11 8

PAC2 25/11/11

Prototipatge 13/11/11 02/12/11

Proves 1 documentacio

Proves 02/12/11 07/12/11

Finalitzaci6 Memoria i Manuals usuari 07/12/11 21/12/11

Elaboraci6 Presentacio 27/12/11 31/12/11
ENTREGA FINAL 01/01/12

Defensa Virtual 02/01/12 10/01/12

3.3 Esforg global i costos

Aquest projecte s'ha dut a terme durant el periode assignat per la universitat a temps
parcial combinant-ho ambla feina a temps complert. Aixi doncs hem realitzat un esforg
mitja diari de 2,5 hores de mitjana els 7 dies a la setmana. A continuaci6 presentem una
taula amb el calcul d'esforgos i el preu orientatiu de les hores invertides calculades amb
una tarifa mitjana de 37€ que pretén ser una aproximacio del que podria costar en el mén
empresarial un projecte d'aquestes caracteristiques. No hem afegit preu de programari

donat que tot el projecte es desenvolupa i es basa en programari lliure i gratuit.

Setmanes 16
Dies/Set 7
Dies Totals 112
Hores/dia 2,5
Esfor¢ Total 280 hores
Mix Preu/Hora € 37,00

Cost € 10.360,00



4 Analisi

4.1 Objectius

L'objectiu d'aquest apartat és estudiar les necessitats del sistema a desenvolupar i els
diferents elements que intervenen en l'aplicacid per tal de donar resposta de forma
acurada als requeriments.

La informaci6 continguda en aquest apartat ha de servir de base per al disseny 1

especificacio del projecte.

4.2 Estat de I'art del m-learning

En el context actual de crisi economica l'ensenyament esta en plena expansié donat que
molta gent aprofita la manca de feina per reciclar-se i la gent i el mercat valoren molt
positivament la formacio6.

El paradigma de les noves tecnologies i els smartphones fa que la necessitat de connexio
amb totes les aplicacions sigui cada vegada més extesa.

Pel que fa a 'ensenyament 1 educacié han adoptat rapidament les noves tecnologies com
a plataforma de difusi6 dels seus continguts mitjangant principalment I'as de campus
virtuals 1 entorns de formaci6 on-line.

Actualment pero el m-learning esta en les seves fases inicials. No gaires dels campus
virtuals o eines de e-learning actuals disposen d'aplicacions propies ni de tercers que
permetin interactuar de forma directa i flexible desde els smartphones.

Existeixen diferents iniciatives orientades a redefinir 'aparenca de les aplicacions web
actuals d'aprenentatge per fer-les explotables des del mobil.

Alguns exemples d'aplicacions no natives son:

= MoMo (Moodle for Mobiles) - Requereix una extensio al servidor per a interficies
mobils; Suporta la major part de SO mobils.

= MLE-Moodle - Permet crear contingut especific als cursos per als usuaris
d'aplicacions mobils.

D'altra banda pel que fa a I'aproximacio mitjangant la connexio a serveis natius dels
sistemes de e-learning aqui els avengos es realitzen més lentament.
Alguns dels principals projectes de e-learning com ara moodle tenen ja alguna aplicacio

nativa amb 10S i estan projectant les versions d'Android.



Malgrat tot la complexitat de l'arquitectura d'aquestes solucions aixi com la necessitat
d'implementar tota una série de serveis externs en les diferents plataformes fan que
aquesta solucions siguin complexes i1 dignes d'un estudi de projecte final de carrera com
el que ens ocupa.

Alguns exemples d'aplicacions natives (algunes en desenvolupament encara) son:

* MoodleTouch (coneguda com a mTouch) per a 10S de apple.
* mPage per i0S i1 Android (en desenvolupament)

*= Mbot per Android (descontinuada)

= L'aplicaci6 oficial de moodle Mobile app per a iPhone.

4.3 Instal-laci6 e-learning i eines
Aquest projecte s'ha dut a terme centrant-nos en l'aplicacio d'e-learning moodle. Hem
escollit moodle perqué:
* Laseva condici6 d'open source ens dona flexibilitat alhora d'analitzar 1
implementar les capes necessaries per a la connectivitat moodle.
 Es una plataforma estesa, robusta i molt contrastada.
* Jadisposa d'una série de serveis web basics que faciliten la feina, I'analisi 1
l'estudi de I'arquitectura, aixi com una primera aproximacio.
* Proporciona un entorn integrat d'instal-lacio que facilita també les tasques propies

de configuraci6 i arrencada del projecte.

4.3.1 Instal-lacié servidor e-learning
Moodle proporciona diferents paquets per a la seva instal-laci6. Concretament hem
emprat un paquet disponible per a macOS ( emprem mac per a realitzar el projecte) que
instal-1a de forma rapida i senzilla tota I'arquitectura necessaria per a disposar d'un
moodle en pocs minuts.
Concretament hem instal-lat:

* Servidor Web Apache

* Base de dades mysql

* interpret de php

* Paquets de l'aplicaciéo web moodle.
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4.3.2 Instal-lacié i configuracio eines desenvolupament.

Per a desenvolupar hem decidit emprar I'IDE eclipse que ens permet treballar de forma

comode amb un projecte d'envergadura.

L'hem personalitzat amb uns connectors utils per al llenguatge php que és el que farem

servir en el desenvolupament.

000 PHP - moodle/codi/message /output/email /message_output_email.php - Eclipse - /U: ic/ubj/111.
r3r BEIBNG EXSDHH® $ 0% |5+ T D &
Navigator £2 S T =0 @ externallibohp & lib.php @ message_cutput_emailohp 51 @) settings.php = 0 & outline &2 “°0
> @ auth <Iphp Bhave”
» > bacup i
» 5 indlude declarations
» (5 blocis
Y@ message_output email
> Gbiog
NOTICE @ send_messagel
» & calendar ;
© config_form0
» @& cohort
© process_form0
» o comment
© load_catald
» @ course o
> @ encal
» @ ermor
» G tiles
s fiter
» @ orade
» @ group
» G it
P > piookup
> @lng
-~
P& hecal
» @ login
¥ (2 messag
¥ (& output
v G email
=
tang
05 _Store
@ lib.php
D) message_output_email.php .
4 settings.php require_once(SCFG-rdirroot. " /messoge/output/lib.php');
4@ version.php
> jabber closs messoge_output_esail extends sessoge_cutput {
> & popup ® * Processes the messase (sends by email)
DS_Stors
4B lib.php Ww W sookmarks | @ P Browser v=0
05 _Store 0 ftems
@ bellvav | Descaiption W Resource Path aten  Type
@ defauitoutputs pho
@ discusvion sip
@ ecnphy
) externallb.sho
& index.php
& oo
@ module s
& rendererpho

Eina de desenvolupament Eclipse

4.4 Analisi dels factors claus web-mobil
Es important destacar que 1'as dels dispositius mobils esta generalitzant-se cada vegada
més en la nostre societat. Actualment l'accés a webs amb dispositius mobils representa un
10% sobre el total i continua creixent. Per aquest motiu €s prioritari que les pagines web 1
els portals web ofereixin serveis especifics per aquestes plataforma.
El nou paradigma mobil requereix:

* Disseny d'interficie adaptada a pantalla petita.

* Alts requeriments d'usabilitat amb tactil i pocs clics.

* Aplicacions de client lleuger.
La tendéncia fins avui per als entorns de e-learning ha sigut adaptar la interficie web per

tal que fos amigable la navegacid en entorns mobils.



Malgrat tot la tendéncia actual i creixent és implementar aplicacions natives per aquests

sistemes emprant entre d'altres els serveis web com a mecanismes de comunicacio.

4.5 Analisi capa de comunicacioé

La interacci6 de I'entorn e-learning amb aplicacions 1 capes externes es realitza
mitjangant un conjunt de serveis web que posen a disposici6 de tercers els serveis més
utilitzats de la plataforma. L'aplicacid disposa també d'una eina per construir serveis de
més alt nivell agrupant un conjunt de funcionalitats basiques que es posa a disposicio de
tercers a mode de funcions web.

Hem decidit utilitzar aquesta capa de comunicacid per a donar els serveis a plataformes

mobils donat que:

* Desacoblen les arquitectures de les diferents capes.

* Deleguen en el servidor les tasques més costoses a nivell de computacio i cost en
temps.

* Sén un protocol estandarditzat per a la interacci6 entre capes.

* Permeten un client lleuger a I'estil dels clients mobils.

El conjunt de serveis web que ofereix la plataforma €s reduit i permet interactuar de
forma senzilla i forca limitada amb I'entorn e-learning des d'aplicacions de tercers.

Es veritat que existeixen molts moduls que permeten integrar connectivitat amb moodle
integrant altres serveis o aplicacions, pero la propia explotacié de moodle fora d'ell

mateix encara €s una assignatura pendent per I'eina.

A continuacio6 detallem el conjunt de serveis web disponibles en ['actualitat:

Objecte

Relacionat Nom del servei web Descripcio
core_user create users() Crea un usuari
core_user delete users() Esborra un usuari

Usuari core_user _update users() Modifica un usuari

core user get users by id() Obté un usuari a partir d'un id
core_user get course user profiles() Obté els perfils d'usuari d'un curs
core_course_get courses() Obté un curs

Curs
core_course_create courses() Crea un nou curs



core_group create groups() Crear un grup

core_group get groups() Obtenir un grup
core_group get course_groups() Obtenir els grups d'un curs
Grups core_group delete groups() Esborrar un gruo
core_group get group members() Obtenir els membres d'un grup
core_group add group members() Afegir membres a un grup
core_group delete group members() Esborrar membres d'un grup
core_role assign roles() Assignar un rol
Rols core_enrol_get enrolled users() Obtenir els usuaris d'un rol determinat
core_enrol get users_courses() Obtenir els membres d'un curs
enrol _manual enrol users() Assignacio manual de roles
core_webservice get site info() Obtenir informaci6 del site de moodle
Varis core_message send instant messages()  Enviar un missatge instantani
core_notes create notes() Crear una nota
. core files get files() Obtenir un fitxer
Fitxers :
core_files upload() Pujar un fitxer

Com s'observa no existeixen actualment serveis web que facilitin les tasques de gestio de
notificacions.
Aixi doncs caldra implementar una pila de serveis destinats a interactuar amb aquest

objectes del entorn e-learning.

4.6 Analisi notificacions

Un sistema de e-learning disposa de diferents tipus de notificacions. Les notificacions
s'agrupen segons el nombre de destinataris ( individuals o col-lectives ), segons el tipus
de emissor receptor ( Professor-Alumne, Alumne-Professor, Persona-Persona) i segons la
tipologia de servei que el genera (Forums,Cursos,Grups,Qiiestionaris,Sistema, Xat).

El nostre sistema ha de poder gestionar aquestes notificacions i permetre retroaccid en
aquells casos en els que tingui sentit.

A continuacio presentem els casos d'iis que permeten analitzar com el sistema ha de

permetre gestionar aquestes notificacions.



4.6.1 Tipus d'alertes i missatges
Moodle te molt poques alertes implementades per defecte.
Ens volem centrar en les alertes de les seglients categories:
* Configuracio de sistema
* Notificacions sistema
* Missatges d'usuaris
e Xats
e (Calendari

* Alertes del campus

4.6.2 Casos d'us
A continuacio presentem el diagrama general dels casos d'is de 'aplicacio de gestio de

notificacions.

X

Rebre
notificacio
alerta

Llista Grups
d'alertes

Veure
Alertes d'un

grup

Veure Alerta

( Retroaccio



4.6.3 Login

Nom

CUI: Login

Actors:

Usuari no logat

Pre-condicions

Tenir un compte a l'eina e-learning corresponent.

Tenir l'aplicacié mobil instal-lada,

Flux Principal:

L'usuari introdueix les seves credencials,

L'usuari prem el boto login,

Flux Alternatiu:

Les credencials son incorrectes.
Es demanen les credencials fins que 1'usuari en posa unes de

correctes.

Post-condicions:

L'usuari queda autenticat a l'aplicacié de forma permanent

4.6.3.1 Logout

Nom

CU2: Logout

Actors:

Usuari

Pre-condicions

Estar logat a I'aplicacié mobil.

Flux Principal:

L'usuari prem el botd de logout

Flux Alternatiu:

Post-condicions:

Es tanca la sessid de 1'usuari

4.6.3.2 Configuracié d'alertes

Nom

CU3: Configuracio de les alertes

Actors:

Usuari

Pre-condicions

Estar logat a 'aplicacio i amb l'aplicacié amb focus.

Flux Principal:

L'usuari marca/desmarca el tipus d'alertes del qual vol ser
notificat per l'aplicacio.

L'usuari confirma els canvis.

Flux Alternatiu:

L'usuari cancel-la en qualsevol moment els canvis.

Post-condicions:




4.6.3.3 Rebre notificacio d'alerta

Nom

CU4: Rebre notificacio d'alerta

Actors:

Sistema

Pre-condicions

Estar logat a 'aplicaci6 i amb l'aplicacié amb focus.

Flux Principal:

El sistema notifica l'arribada d'una nova alerta.

L'usuari selecciona l'alerta per visualitzar-la a 1'aplicacio.

Flux Alternatiu:

L'usuari esborra l'alerta del notificador del sistema.

Post-condicions:

L'alerta es dona per notificada.

4.6.3.4 Llistar grup d'alertes

Nom

CUS: Llistar grups d'alertes

Actors:

Usuari

Pre-condicions

Estar logat a 'aplicacio i amb l'aplicacié amb focus.

Flux Principal:

El sistema llista els grups d'alertes disponibles indicant si hi
ha o no noves notificacions.

L'usuari selecciona un dels grups per visualitzar

Flux Alternatiu:

L'usuari surt de 1'aplicacio.

Post-condicions:

Podem tenir un grup de notificacions seleccionat per a

visualitzar.

4.6.3.5 Veure alertes d'un grup

Nom

CU6: Veure alertes d'un grup

Actors:

Usuari

Pre-condicions

Estar logat a I'aplicaci6 i amb l'aplicacié amb focus. haver

fet préviament el CUS.

Flux Principal:

El sistema llista les notificacions del grup, permeten accedir

al detall d'una notificacid concreta

Flux Alternatiu:

L'usuari surt de 1'aplicacio.

Post-condicions:

Podem tenir una alerta concreta seleccionada per visualitzar.




4.6.3.6 Veure alerta

Nom

CU7: Veure el detall d'una alerta

Actors:

Usuari

Pre-condicions

Estar logat a I'aplicaci6 i amb l'aplicacié amb focus. haver

fet préviament el CU6 o el CU4.

Flux Principal:

El sistema mostra els detalls de la notificaci6 i les possibles

retroaccions a realitzar.

Flux Alternatiu:

L'usuari surt de 1'aplicacio.

Post-condicions:

Podem tenir una retroaccid seleccionada per dur a terme.

4.6.3.7 Retroaccio a una alerta

Nom

CUS: Realitzar retroaccid sobre una notificacid

Actors:

Usuari

Pre-condicions

Estar logat a I'aplicaci6 i amb l'aplicacié amb focus. haver

fet previament el CU7.

Flux Principal:

El sistema mostra els detalls de la retroaccio6 a realitzar.
L'usuari omple els camps necessaris de dades.

L'usuari confirma la retroaccio.

Flux Alternatiu:

L'usuari surt de 1'aplicacio.

L'usuari no confirma la retroaccid

Post-condicions:

L'usuari ha finalitzat d'interactuar amb la notificacio i es

torna a la pantalla anterior.

4.7 Resum funcional

En definitiva pretenem dissenyar un software que ens permeti rebre i interactuar amb les
notificacions del nostre sistema de e-learning. El sistema ha de permetre accedir a la

nostra configuraci6 d'alertes (amb autenticacio previa) i poder rebre les alertes de forma

automatica aixi com realitzar retroaccions.

Per poder implementar aquesta aplicacio ens cal primer dissenyar un middleware que ens

abstragui de la capa d'aplicacié web i que permeti a I'aplicacid mobil interactuar amb el

sistema d'una forma estandard, lleugera i desacoblada.




Caldra també contemplar uns petits retocs per tal de poder gestionar la configuracid
d'aquests serveis web en el servidor moodle aixi com poder gestionar quines notificacions

1 alertes estan disponibles al mobil.



5 Disseny

5.1 Arquitectura

Moodle té una arquitectura d'aplicacié web en PHP. El disseny del software €s per capes 1
absolutament modular.

D'aquesta manera tenim a la capa més baixa la persistencia i la gestié de 'accés a aquesta
mitjangant una seria d’interficies i classes.

Immediatament a sobre de la capa d'accés a dades tenim la capa de negoci o el nucli de
l'aplicacid que ofereix els serveis propis de 'aplicacio base.

Finalment disposem d'una capa de presentacid que s'encarrega de generar les vistes que
finalment estaran disponibles per als usuaris.

D'altra banda a nivell funcional moodle també esta dissenyat per capes.

Disposa a baix nivell de classes i objectes que ofereixen funcions atdmiques sobre el
sistema.

Aquestes funcionalitats es poden agrupar en serveis o blocs funcionals dedicats a
processos més elaborats.

Finalment aquests serveis poden estar disponibles per a tercers mitjancant protocols SOA.
La modularitat de moodle i un dels motius de la seva gran acceptaci6 i creixement és la
facilitat de desenvolupar funcionalitats addicionals en forma de p/ugin que permeten
estendre de forma desacoblada les funcionalitats de moodle donant-li una poténcia i

flexibilitat sense limits.

Arquitectura moodle




5.1.1 Concepte de context
El context en una aplicacié de e-learning defineix un espai determinat on s'executen les
accions o s'accedeix a contingut.

A continuacio6 presentem graficament la jerarquia de contexts de moodle:

System
User
Front page (Site course)
Activity module I Block I
Course category
Course
Activity module I Block I

La jerarquia detallada dels diferents nivells de context és la segiient :

CONTEXT_SYSTEM Tota l'aplicacio 10
CONTEXT_USER Context d'usuari 30
CONTEXT_COURSECAT Categoria de curs 40
CONTEXT_COURSE Curs 50
CONTEXT_GROUP Grup 60
CONTEXT_MODULE Modul o activitat 70
CONTEXT_BLOCK Bloc 80

Moodle ens proporciona un conjunt d'eines per treballar amb el context a nivell de
programaci6 que ens permeten diferenciar el context en el que ens trobem. Aixo ens
ajuda principalment per a:
* Controlar a nivell molt detallat la seguretat a funcionalitats
* Permetre comportaments diferents per a funcionalitats segons el context on es
duguin a terme i identificar en tot moment qui 1 on es realitza una accio.

* Poder definir rols i permisos d'aplicacio.



Capabilities

Moodle defineix a més dels contextes un conjunt de capabilities o capacitats que
permeten assignar permisos sobre funcionalitats concretes de tots els detalls de 'aplicacio
tant a nivell d'usuari com a nivell de rol.
Aquestes capabilities combinades amb el context ajuden a gestionar convenientment la
seguretat i altres capacitats que ofereix I'eina.
Les capabilities s'estructuren de forma jerarquica seguint I'arquitectura modular de
moodle. Alguns exemples de capabilities son:

* (Capabilities/moodle/course:create

* (Capabilities/moodle/course:delete

* (Capabilities/moodle/course:manageactivities

* (Capabilities/moodle/course:managefiles

* (apabilities/moodle/course:managegrades

5.1.2 Serveis web

5.1.2.1 Gestio de serveis web
Per a la gestio de serveis web moodle disposa de funcionalitats de configuracio que
permeten:

* Activar o desactivar la disponibilitat dels serveis web.

* Crear funcions especifiques agrupant diferents serveis web

External services

Enable mobile web service @ Default: No

Enabie matile service for the official Moode app o 0ther app fequesting it

e documentation

It Is recommended to enable HTTPS with a valkd certificate. The Moodie app wil aiways try 10 Use @ 5ecured Connection frst.

Information

A sorvice is a et of functions. A service can be accessed by all users of just specified users.

Built-in services
s i = T .

Moodie mobile web service moodie Functions Al users Edt

get_nctfications_enric Deleto Functions Al users Edt

Asd
Save changes.

Gestio de serveis web de moodle



Hem definit un servei personalitzat que engloba totes les funcions de serveis web

implementades per tal de poder donar accés als usuaris d'una forma eficag i controlada.

5.1.2.2 Gestio de notificacions disponibles externament

D'altra banda per gestionar les notificacions es disposa de funcionalitats per activar o
desactivar els diferents tipus de notificacions. (email,popup,jabber)

Per tal de donar servei a les notificacions a tercers hem creat un nou proveidor de servei
que ens permetra configurar quines alertes de sistema volem que estiguin disponibles
externament.

Aquesta part de 1'eina de e-learning caldra modificar-la afegint la possibilitat d'activar

alertes mobils.

5.1.3 Us del middleware per a tercers

5.1.3.1 Introduccio

L'objectiu principal del programari dissenyat és permetre a aplicacions externes accedir a
les funcionalitats de moodle. L'arquitectura dissenyada va més enlla de les notificacions i
missatges ja que permet ampliar la pila de serveis web per tal d'exposar tots els
components de moodle que es necessitin en el futur. Un dels punts claus de les
aplicacions en entorns mobils es el consum d'energia i la connectivitat a internet que
necessiten optimitzar al maxim. Per aquest motiu l'arquitectura del middleware ha de

tenir en compte aquests aspectes.

5.1.3.2 Mode d'accés pull als serveis

El mode d'accés push als serveis és el mode tradicional de servei a petici6 del client.
Aquest mode implica que les aplicacions de tercers han de fer peticions periodiques als
serveis per actualitzar la informacié disponible.

Si bé aquest és el meétode més estes no €s el més Optim sobretot per a les aplicacions
mobils que pretenen consumir poca energia i poc accés a dades que sol ser de pagament.
Es d'altra banda el mode més senzill d'implementar ja que no afecta en l'arquitectura.

A continuaci6 presentem un esquema del mode d'accés pull.



Esquema servei web amb pull

Dades Peticions
Notificacions actualitzacié
+ S'informa y + Alta frequencia
nomes a peticio. * Requereix energia
No té visibilitat g | connexio de
del client. dades.

5.1.3.3 Mode d'accés push

El mode d'accés push consisteix en invertir el paper entre el client i el servidor 1 permetre
al servidor enviar missatges al client de forma asincrona sense necessitat d'estar
permanentment interrogant des del client.

Es diu que el client queda en mode escolta passiva que li permet no consumir energia ni
dades fins que no sigui necessari per a rebre l'actualitzaci6 corresponent.

Aquest metode s'ha imposat degut a les restriccions de bateria i accés a dades de les
plataformes mobils i és I'estandard actual per a aquests tipus de serveis.

El principal inconvenient és que requereix un tercer actor que faci d'intermediari i escolti
al servidor per enviar les dades a client.

D'altra banda l'esfor¢ d'implementaci6 és superior donat que cal preparar tant el client
com el servidor per connectar-se amb aquest servei tercer.

L'esquema de funcionament del metode push funciona mitjangant el registre de les dues
capes (client i servidor) en el servei de missatgeria push.

Un dels més extesos actualment és el de google al cloud ( Android Cloud to Device
Messaging) anomenat col-loquialment C2DM.

A continuacid presentem un diagrama de funcionament del metode push.



Serd registrotion code +o Agplication Server

web Applicotion Server
Funcionament del registre a google C2DM 1

‘ Serd message to device with ID
|

Z"w,c sent 4o ogplication on dovice ‘
|

Enviament de missatges mitjancant C2DM 1

5.1.3.4 Métode escollit

Malgrat que el meétode push sembla el més adient de cara a les aplicacions mobils. Hem
decidit implementar els webservice sense cap entorn de notificaci6 activa donat que el
temps que requeria d'investigacio 1 coneixement quedava fora de 1'abast incial del
projecte.

En aquest projecte s'han implementat principalment els webservices 1 les capacitats a
moodle per exposar dades per tercers 1 l'arquitectura de com exposar-les en el cas de les
aplicacions mobils ha quedat en part fora de 'abast.

Val a dir pero que afegir una capa de notificacio activa de missatges (push) no afectaria
als serveis desenvolupats actualment i per tant el plantegem com una possibilitat de
millora o ampliaci6 del projecte, ja que s'ha tingut en compte alhora de desenvolupar que

el sistema fos suficientment desacoblat.



5.2 Especificacié del middleware

En aquest apartat ens centrarem en l'especificacié concreta del middleware. Per fer-ho
dissenyarem els canvis necessaris en el sistema d'e-learning actual, les funcionalitats
noves a desenvolupar a mode de connector i finalment l'especificacio detallada d'aquest

sistema.

5.2.1 Modificacions en el sistema de e-learning

Com ja hem comentat caldra fer certes modificacions en el servidor actual de e-learning.

5.2.1.1 Afegir un message provider per als serveis web
Concretament haurem d'afegir la possibilitat de tenir disponibles les alertes a traves del

mobil en la configuracié dels serveis web externs.

Modificacio Afegir configuraci6 alertes mobils
Modul afectat Message
Descripcié Canvis Afegir possibilitat d'enviar alertes al mobil per

a cadascun del tipus d'alertes disponibles

Especificacio Canvis Afegir un messageProvider Mobil similar als

que existeixen de Mail,Jabber i Popup

Ruta fitxers htdocs/moodle/message
htdocs/moodle/message/output
fitxer edit.php

el nom del message provider sera mobile i
Detalls I'hnaurem també de registrar a la capa de
persisténcia

A continuaci6 adjuntem una captura de pantalla amb el resultat visible de la modificacio.



-1 Configure notification methods for incoming messages:

Navigation
Popup notification mobile Email
Home
s My home Assignment notifications
) Site pages When I'm logged in &) “
> My profile When I'm offline “ “
» Courses
Backup notifications
- =) When I'm logged in “ c)
Settings 1 99
N When I'm offiine “ “
¥ My profile settings
= Edit profile Confirmation of your own quiz submissions
= Change password When 'm logged in ] 1
» Roles @ P
= Messaging When I'm offline
» Blogs Course creation request approval notification
) Site administration When I'm logged in [ ]
When I'm offiine “ ]

Search

Course creation request notification
When I'm logged in “ “
When I'm offline “ “
Course creation request rejection notification
When I'm logged in &) “
When I'm offline & “
Important errors with the site
When I'm logged in o “

When I'm offiine “ “

Essay araded notification

5.2.1.2 Modificacions en méduls existents
S'han fet modificacions en els moduls existents de moodle per crear algunes funcions
addicionals que faciliten I'explotacié mitjancant serveis web.
Aquestes modificacions afecten a:
* Messages
* Forums

e (Calendar

5.2.2 Especificacio dels Serveis Web

El middleware estara principalment centrat en oferir un conjunt de serveis web.

Hem escollit la tecnologia XML-RPC donat que és la més senzilla, pero alhora la més be
integrada amb I'eina.

Moodle disposa d'un mecanismes de plugins per a implementar serveis web i d'una
plantilla estandard que permet desenvolupar els web services i integrar-los directament de
forma transparent pel sistema servidor.

Aquesta plantilla sera la base de la nostra especificacio.



client

Conté els fitxers necessaris per al client de test del WS

client.php Fitxer de client per al test del WS
curl.php Fitxer del core del client de test
db Conté els fitxers necessaris per al registre del WS

services.php

Fitxer de registre del WS a moodle

lang

Literals d'idioma

en

Anglés

local_wstemplate.php

Fitxer que conté els literals del WS

externallib.php

Implementacié de les funcions estandards del WS

version.php

Informacié de la versid

README

Informacié variada del WS

A continuacid presentem un exemple de les funcions d'un webservice anomenat

welloWorld.

Contingut del fitxer externalib.php

public static function hello_world_parameters() {
return new external_ function_parameters(

array( 'welcomemessage' => new external_value(PARAM TEXT, 'The welcome

message. By default it is "Hello world,"', VALUE DEFAULT, 'Hello world, "))

)i
}

public static function hello_world($welcomemessage = 'Hello world, ') {

global S$SUSER;

$params = self::validate parameters(self::hello world parameters(),
array( 'welcomemessage' => Swelcomemessage));

$context = get_context_instance(CONTEXT USER, $USER->id);
self::validate context($context);

if (!has_capability('moodle/user:viewdetails', $context)) {
throw new moodle_exception('cannotviewprofile');

}

return S$params|[ 'welcomemessage']

}

SUSER->firstname ;;

public static function hello_world_returns() {

return new external_value(PARAM TEXT,

}

'The welcome message + user first name');



Contingut del fitxer services.php

sfunctions = array(

'local wstemplate hello world'

=>
=>

'classname’
'methodname’
'classpath’ =>
'description' =>
sending a new text
'type' =>

(Hello World)

)

Sservices = array(
'My service' => array(
'functions’

'enabled'=>1,

=> array (
'local wstemplate external',
'hello _world',

'"local/wstemplate/externallib.php',

'Return Hello World FIRSTNAME.
as parameter',
'read',

= 0,

Un servei web de moodle requereix:

e Documentacio.

* Funcions principals del Servei web.

* Tipus de parametres d'entrada.

* Tipus dels valors de retorn.

* Permisos de I'entorn moodle per a l'execucio.

* Registre al sistema moodle.

* Mapping del servei a funcions.

A continuacio detallarem els serveis web necessaris a implementar per tal de poder oferir

servei de connectivitat per a 'aplicacié de gestio.

Can change the text

=> array ('local wstemplate hello world'),
'restrictedusers'’

Val a dir que amb l'especificacié que hem realitzat la implementacio esdevé gairebé

directa ja que tenint el model estandard de servei web només ens caldra implementar les

funcions generiques per als serveis web amb els parametres i permisos especificats més

avall.



5.2.2.1 Configuracié d'alertes i missatges

uoc_get _message_profile

Core function name

uoc_get_message_profile()

Parameter types

returned value types

Estructura de message profiles

user capabilities

/moodle/user:editmessageprofile

/moodle/user:editownmessageprofile

Descripcié

Obté la configuracié d'enviament de
missatges

uoc_update_message_profile

Core function name

uoc_update_message_profile()

Parameter types

Estructura de message profiles

returned value types

result --> Integer

user capabilities

/moodle/user:editmessageprofile

/moodle/site:config

/moodle/user:editownmessageprofile

Descripcié

Modifica la configuracié d'enviament de
missatges

5.2.2.2 Notificacions sistema

uoc_get _recent_notifications

Core function name

uoc_get_recent_notifications()

Parameter types

Userld--> Integer

returned value types

Notifications List

user capabilities

Descripcié

Permet retornar les ultimes n notificacions

uoc_get _unread_notifications

Core function name

uoc_get_unread_notifications()

Parameter types

Userld--> Integer

returned value types

Notifications List

user capabilities

Descripcié

Permet retornar les notificacions no
llegides




5.2.2.3 Missatges d'usuaris

uoc_count_user_unread_messages

Core function name

uoc_count_user_unread_messages()

Parameter types

Userld--> Integer

returned value types

unreadMessages-->Integer

user capabilities

Descripcié

Retorna el nombre de missatges no llegits

uoc_get_user_unread_messages

Core function name

uoc_get user_unread_messages()

Parameter types

userld --> Integer

returned value types

Estructura de missatges

user capabilities

/moodle/site:readallmessages

/moodle/site:config

/moodle/user:editownmessageprofile

Descripcié

Retorna els missatges no llegits i els marca
com a llegits

uoc_send_message

Core function name

uoc_send_message()

Parameter types

fromUserld --> Integer toUserld --> Integer
Subject--> String Message-->Text

returned value types

result --> Integer

user capabilities

/moodle/site:readallmessages

/moodle/site:config

/moodle/user:editownmessageprofile

Descripcié

Permet enviar un missatge a un usuari




5.2.2.4 Xats

get_instant_messages

Core function name get_instant_messages()

Parameter types userld --> Integer

returned value types Estructura de missatges

user capabilities /moodle/site:readallmessages

Descripcié Obté els missatges instantanis d'un usuari

send_instant_messages ( Ja existeix al core de moodle)

Core function name send_instant_messages()

fromUserld --> Integer toUserld --> Integer
Parameter types Subject--> String Message-->Text
returned value types result --> Integer

/moodle/site:readallmessages
user capabilities /moodle/site:config

/moodle/user:editownmessageprofile

Descripcié Permet enviar un missatge a un usuari

5.2.2.5 Calendari

uoc_get_user_calendar_events

Core function name uoc_get user_calendar_events()
Userld--> Integer Courseld--> Integer
Groupld-->Integer StartDate-->date
Parameter types EndDate-->date

returned value types Event List

Capabilities/moodle/calendar:manageentries
Capabilities/moodle/calendar:managegroupe
user capabilities ntries
Capabilities/moodle/calendar:manageownen
tries

Obté els events d'un interval de dates del
Descripcié calendari d'un usuari,grup o curs

5.2.2.6 Alertes del campus
Es duran a terme amb els serveis web existents en la implementaci6 base de moodle. No

hem cregut necessari l'especificacid d'aquests webservices ja existents.



6 Implementacio

6.1 Arquitectura del sistema implementat

Per tal d'implementar els middleware de serveis web hem estudiat 1'arquitectura de 1'eina
d'e-learning per integrar de la forma més flexible possible aquest middleware.

Hem implementat cadascun dels serveis web com un plugin independent de tal manera
que disposem d'una arquitectura modular i totalment escalable que ens permet anar
afegint funcionalitats de forma gradual sense afectar en absolut el funcionament dels
altres serveis web.

Aixi doncs hem definit per a cada servei web:

1.- Plugin que el conté dins el directori de modificacions locals (local)

2.- Servei web que el plugin implementa.

3.- Funci6 del servei web que proporciona la funcionalitat de moodle. ( enllag amb el
core de moodle)

4.- Client de prova per al test del servei web.

Per al conjunt de serveis web hem definit un servei extern personalitzat (uoc ws) que
engloba les funcions de tots els serveis web a nivell d'accés per als usuaris.

S'ha definit un token per al servei extern ( un per cada usuari de prova ) centralitzant aixi

la seguretat i I'accés a tots els serveis webs en un unic punt.

. ' Built-in services
> My profile settings

¥ Site administration External service Plugin Functions Users Edit

[l Notifications Moodle mobile web service moodie Functions All users Edit

[R\ Registration

R Advanced features uoc_get_count_unread_messages local_uocgetcountuserunreadmessages Functions All users Edit

> Users N

b G uoc_get_message_profile local_uocgetmessageprofile Functions All users Edit
ourses

) Grades uoc_get_recent_notifications local_uocgetrecentnotifications Functions All users Edit

» Location

> L uoc_get_unread_notifications local_uocgetunreadnotifications Functions All users Edit
anguage

¥ Plugins uoc_get_user_unread_messages local_uocgetuserunreadmessages Functions All users Edit

[ Plugins overview
» Activity modules
» Blocks uoc_update_message_profile local_uocupdatemessageprofile Functions All users Edit
> Message outputs
» Authentication

» Enrolments

P Text editors

uoc_reply_notification local_uocreplynotification Functions All users Edit

Custom services

External service Delete Functions Users Edit
» Licences
» Filters moodle ws Delete Functions All users Edit
» Repositories
P uoc ws Delete Functions All users Edit
¥ Web services
R Overview
[RAPI Documentation Add

External services
[2 Manage protocols
[21Manage tokens

Save changes



Home » Site administration » Plugins » Web services » Manage tokens

Navigation Sl

Home

My home
) Site pages
> My profile
» Courses

Admin bookmarks Il

bookmark this page

Settings =10

> My profile settings

v Site administration
[R Notifications

Token

¢3b0836f69717f0db0Obafaacc6d48461

2677b8b25777535¢7a6¢1477667b1b6b

afc32f18820b7778b2ccc2¢c7e276d9bb

896aaaecee3fbc8fb3d46aff5d55¢7bs

Manage tokens

User

- Admin -

- Admin -

Enric Biosca

apabilities: moodle/user:viewdetails,moodle/user.viewt

Enric Biosca

Blocks editing on

[B)Registration @
[R|Advanced features b7. 09 766 Enric Biosca
> Users

» Courses Add

6.2 Consideracions de seguretat
Moodle ofereix un sistema de gestio d'accés tant als seus recursos com als serveis web.
Per al projecte hem utilitzat a nivell de seguretat tres funcionalitats especifiques:
* Us de https en les peticions de tokens i Serveis web
* Restriccions a les funcionalitats mitjangant les capabilities de moodle que
gestionen l'accés a la capa core de I'aplicaci6 per part dels diferents perfils
d'usuaris.
* Utilitzacio del protocol d'autoritzaci6 compartida mitjancant tokens definits a
nivell d'aplicacid per l'administrador.
Des de la darrera versio de moodle ( que ha sortit en el transcurs del projecte) una
aplicaciod pot accedir al token d'identificacié d'un usuari mitjangant una simple peticid
https. Aix0 facilita 'accés a moodle des d'altres plataformes.
El concepte doncs de login i logout queda simplificat amb l'obtenci6 del token i la

caducitat del token que es pot configurar a nivell d'administracié de moodle.

6.3 Exemple complet d'un servei web

Com ja hem comentat hem creat els serveis web com a plugins o connectors de moodle.
Aquest fet ens permet un desenvolupament modular i1 extensible molt adeqiiat per al
projecte que ens ocupa.

A continuaci6 descriurem el procés resumit d’implementacié d’un webservice del

projecte a mode d’exemple



6.3.1 Creacio estructura de fixters
S’ha creat dins el directori local la segiient estructura de carpetes per cada plugin

= |2 uvocnomplugin
I client
) db
= 12 lang
) en

6.3.2 Definicio dels noms dels serveis i funcions
S’han definit els noms del servei i les funcions que posem a disposici6 de tercers al fitxer

services.php

Sfunctions = array(
‘'uoc_get_unread_notifications' => array(
‘classname’ => 'uoc_get_unread_notifications_external’,
‘'methodname’ => 'uoc_get_unread_notifications’,
‘classpath’ =>'local/uocgetunreadnotifications/externallib.php’,
‘description’ => 'obte les notificacions no llegides’,

‘type' => read’,

// We define the services to install as pre-build services. A pre-build service is not
editable by administrator.
Sservices = array(
‘'uoc_get_unread_notifications' => array(
‘functions’' => array (‘'uoc_get_unread_notifications’),
'restrictedusers' => 0,

‘enabled'=>1,

6.3.3 Configuracié descripcions i literals
En el fitxer anomenat local nomdelplugin.php hem configurat els literals d’idioma

necessaris.

$string['pluginname'] = "UOC WS get unread notifications';




6.3.4 Implementacio de les funcions del servei web

En el fitxer externallib.php hem implementat les funcions propies de la interficie de

classe externa que es requereixen:
* funcio_a implementar( ) :
* funcio_a implementar parameters( )

* funcio_a implementar returns( )

require_once($CFG->libdir . "/externallib.php");
class uoc_get unread notifications_external extends external api {

public static function uoc_get unread notifications parameters() {

return new external function parameters(
array('usr' => new external_value(PARAM INT, 'id of the sender user"))

}

public static function uoc_get unread notifications_returns() {
return new external multiple structure(
new external_single structure(

array(
'message_read_id' => new external value(PARAM_INT, 'Messsage ID'),

'smallmessage' => new external value(PARAM TEXT,'small message,.."),
'fullmessage' => new external value(PARAM TEXT, 'full message', VALUE OPTIONAL),
'timecreated' => new external_value(PARAM_INT, 'time created'),

‘contexturl' => new external value(PARAM TEXT,'context url', VALUE OPTIONAL),

'contexturlname' => new external value(PARAM_TEXT,'contexturlname'),

), 'notifications'




public static function uoc_get_unread_notifications($usr) {
global $CFG, SUSER, $DB;
require_once($CFG->dirroot . "/message/lib.php");
//check if messaging is enabled
if ('$CFG->messaging) {

throw new moodle exception('disabled’, 'message');

// Ensure the current user is allowed to run this function
$context = get_context instance(CONTEXT_SYSTEM);
self::validate context($context);

require_capability('moodle/site:sendmessage’, $context);
$params = self::validate_parameters(self::uoc_get unread notifications_parameters(), array('usr' => Susr));

//retrieve count of unread messages
$notifications = message get recent notifications(SUSER,0,100);
$notificationsinfo = array();

foreach ($notifications as $notification) {

$notificationinfo = array();
$notificationinfo['message_read_id'] = $notification->message_read_id;
$notificationinfo['smallmessage'] = $notification->smallmessage;
$notificationinfo['fullmessage'] = $notification->fullmessage;
$notificationinfo['timecreated'] = $notification->timecreated;
$notificationinfo['contexturl'] = $notification->contexturl;
$notificationinfo['contexturlname'] = $notification->contexturlname;
$notificationsinfo[] = $notificationinfo;

}

return $notificationsinfo;

6.3.5 Instal-lacié plugin al moodle
Un cop desenvolupat el plugin cal instalar-lo desde la part d’administracié del site de

moodle.

6.3.6 Afegir la funcié al servei extern o crear token propi
Per tal que estigui disponible per als usuaris de la plataforma de forma externa cal crear

un token per a la funci6 especifica del servei web.



Hem creat un servei extern anomenat uoc ws que permet agrupar totes les funcions

implementades en un servei compartint el token.

ns » Web services » Manage tokens

Token

¢3b0836f69717f0db0bafaacc6d48461

2677b8b25777535¢7a6¢1477667b1b6b

07ec92660a6370b37e8e2eadabfd11c0

afc32f18820b7778b2ccc2c7e276d9bb

896aaaecee3fbc8fb3d46aff5d55¢7b5S

3b7252b3809db36097d0599b520627e6

- Admin -

- Admin -

- Admin -

Enric Biosca
Missing capabilities: moodle/user:viewdetails,moodle/user:viewhiddendetails, moodle/course:useremail, moodle/user:update, moodle/site:viewparticip:

Enric Biosca
Missing capabilities:
moodle/course:managegroups, moodle/user:create,moodle/user:viewdetails,moodle/user:viewhiddendetails, moodle/course:useremail, moodle/user:upc

@

Enric Biosca

Manage tokens

6.4 Creacidé del message processor mobile

| Blocks editing on |

Hem implementat un nou modul de message processor adicional que permet activar o

desactivar les alertes disponibles via els serveis web de mobile.

Navigation

Home

= My home
) Site pages
» My profile
» Courses

Settings S

¥ My profile settings
= Edit profile
= Change password
» Roles
= Messaging
» Blogs

¥ Site administration

| search

~Configure

methods for

Popup notification mobile Email

Assignment notifications

When I'm logged in O

When I'm offline -

Backup notifications

When I'm logged in O

When I'm offline -

Confirmation of your own quiz submissions

When I'm logged in U

When I'm offline J

Course creation request approval notification

When I'm logged in o

When I'm offline

Course creation request notification

When I'm logged in )

When I'm offline

Course creation request rejection notification

When I'm logged in )

When I'm offline -

Important errors with the site

When I'm logged in _

When I'm offline -

Essay araded notification

)
o

)
c)

c)
“

“
“

“
“

“
“

“
“



6.4.1 Definici6 dels nous messages providers
Hem definit una série de messages providers nous per tal de poder configurar el tipus
d’alerta que 1’usuari tindra disponible a 1’entorn mobile.
e Xat
* Forum
* Missatges directe
Aquests messages providers no tenen fitxers associats sind simplement es registren a la

base de dades com a capabilities 1 message providers a la taula corresponent.

6.4.2 Modificacions a llibreries actuals
Algunes de les notificacions i alertes que es basen en moduls ja implementats han
requerit modificacions respecte al seu comportament inicial.
Per fer-ho el més mantenible possible no hem modificat cap de les funcions actuals dels
moduls sind que hem implementat funcions noves amb una nomenclatura determinada.
Algunes d’aquestes funcions son:

e get unread messages uoc_ws() al modul message

e get user calendar events uoc_es al modul calendar

6.5 Abast de la implementacio final realitzada

L'objectiu principal del projecte era el disseny i especificacié d'un programari
middleware per a la gesti6 de notificacions en un entorn d'e-learning.

La culminacid d'aquest objectiu és a banda d'aquest document la generaci6é completa de
l'arquitectura que entreguem disponible per a la seva instal-lacio.

Aquest prototip conté tots els serveis web que amb clients de prova que estan accessibles
1 funcionen amb unes dades d'exemple.

Com a objectiu complementari hem implementat finalment la meitat dels serveis web de
tal manera que la nostra aplicacié disposa del prototipus de tots els serveis i la

implementaci6 de la meitat.



7 Canvis respecte a entregues anteriors

Com en tot projecte viu durant la realitzacié d'aquest projecte hem anat aprofundint en la

materia i aix0 ha implicat canvis en els plantejaments posteriors. En aquest apartat volem

fer mencio dels més significatius a nivell d’analisi, disseny o implementacio.

Respecte a l'entrega de la PAC2 s'ha modificat:

Relacid i nomenclatura final dels serveis web a implementar

Agrupaci6 de notificacions en categories/grups per a facilitar la seva gestio
Hem afegit la creaci6é d'un message processor i de message providers per la
gestio d'enviament de notificacions.

S'ha tingut en compte 1'alternativa push/pop a nivell de disseny

S'ha actualitzat la versi6 de moodle a la 2.2 que aporta noves funcionalitats a nivell de

seguretat 1 login que faciliten la integraci6 per part de tercers.

8 Linies futures d'actuacio

Un cop finalitzat el projecte volem proposar alguns temes que per abast han quedat fora

del projecte o que son complementaris per tal de que puguin servir de vies d'ampliacio 1

serveixin també per exemplificar fins on hem arribat amb el projecte.

Utilitzar tecnologia de missatgeria push que sembla més adequada per a les noves

plataformes mobils.

Ampliar el conjunt de serveis per a apartats com:
o Qualificacions
o Resultats de qiiestionaris

Implementar els serveis web amb d'altres tecnologies com REST o SOAP.



9 Conclusions

Un cop finalitzat el projecte és hora de fer balang. Primer de tot fer balang del
compliment dels objectius esperats en l'inici del projecte.

A nivell global el projecte m'ha servit efectivament per consolidar coneixements de
l'assignatura a nivell horitzontal.

També s'han assolit els objectius técnics de proporcionar un middleware per a 1'is a
aplicacions de tercers i connexié amb I'entorn moodle per a la gestio de notificacions 1

missatges.

A nivell personal el treball fort i concentrat en pocs mesos m'ha servit per aprendre a

planificar-me i esforcar-me per aconseguir un objectiu determinat en el camp de la feina.

Fer un projecte complementari amb una altra alumna m'ha servit per aprendre a
coordinar-se a distancia amb algu i1 saber que la feina que fas sempre 1'ha de poder

entendre 1 reutilitzar una altra persona. Punts claus en la nostra professio.

A nivell de satisfaccié amb el projecte he de dir que estic satisfet per la feina duta a terme
donat que no havia tocat php en tota la carrera ni en la meva vida professional i me'n he
sortit prou bé alhora d'implementar-ho.

He aprofundit en els coneixements de moodle i de tecnologia web en php.

He apres sobre serveis web 1 protocols de comunicacio.

He de reconeixer que tot i anar una mica perdut al principi I'esfor¢ fet durant la darrera
entrega m'ha permes quedar més satisfet.

Tot 1 aixi m'agradaria fer una mica d'autocritica donat que en certs moments no he dedicat
tot l'esfor¢ que el projecte requeria i la implementacio no ha pogut arribar a ser completa

tot i no ser un objectiu principal.

Espero que amb la lectura de la memoria es pugui apreciar la feina feta tant en analisi i
disseny com en la part de definici6 i implementaci6 de 1'arquitectura dels serveis web 1

els plugins de moodle.



Moment també de fer balang de tot el que he apres a la UOC en els estudis d’enginyeria
informatica. Dur-los a terme m'ha servit per ampliar els meus coneixements tant técnics
com teorics sobre la nostra professio i també¢ a planificar temps i esfor¢os per poder

compaginar feina i estudis d'una forma satisfactoria.



10 Manual d'instal-lacio i

10.1 Manual d'instal-lacid

Hem proporcionat un paquet comprimit amb tot el necessari per la instal-lacié del

middleware.

Estructura de la instal-lacio:

T4

us

CARPETES DESCRIPCIO

moodle22 Carpeta arrel de la instalacié de moodle a apache
local Carpeta de modificacions locals
uocgetupdatemessageprofile Carpeta d'un plugin
client detall del plugin
db detall del plugin
lang detall del plugin

uocgetmessageprofile

uocgetrecentnotifications

uocgetunreadnotifications

uocgetuserunreadmessages

uocsendmessage

uocgetuserinstantmessages

coremessagesendinstantmessages

uocgettodayevents

Carpeta d'un plugin

moodle22_modif

fitxers modificats del core de moodle

calendar calendari
messages missatges
output configuracié d'un nou proveidor d'alertes
mod Moduls de moodle
forum Forum

Per fer-ho només ens caldra copiar la carpeta moodle 22 en una versi6é de moodle 22 i ja
tindrem tot el necessari per instal-lar els plugins, ja que les nostres carpetes només

afegeixen contingut i no modifiquen res.

Pel que fa a les modificacions de moodle recomanem fer una copia dels fitxers a sobre
escriure que podeu veure dins de les carpetes.

Un cop feta la copia es pot procedir a copiar els directoris proporcionats que substituiran
només aquells fitxers necessaris.

Recordeu que no hem eliminat res sin6 simplement hem afegit funcions noves en alguns

dels moduls i per tant no queda afectada la funcionalitat de moodle.

10.1.1 Activacioé dels serveis web
Per activar els serveis web ens caldra un cop instal-lats els fitxers entrar a moodle com a

administradors 1 automaticament ens demanara d'instal-lar els serveis web.



Un cop instal-lats podem anar a la gestid de serveis web per activar-los 1 generar un

servei extern que agrupi les funcions disponibles sota un tnic token d'accés de seguretat

Home » Site administration » Plugins » Web services » External services Blocks editing on
Navigation e i

< External services
Home
+ My home
» site jes

peg Enable mobile web service @ Defauit: No

» My profie enablemobiiewebservice
e Enable mobile service for the offcal Moocle app or other app requesting it For mre information,read the Moodle documsntation

ourses

Itis recommended to enable HTTPS with a valid certificate. The Moodle app will always try to use a secured connection first.

Admin bookmarks o
bookmark this page Information

Aservice s a set of functions. A service can be accessed by all users or just specified users.
Settings 0

Built-in services
» My profile settings

= S adminisration Extemal service Plugin Functions. Users Edit

Bl Notiications Moodie mobile web service moodie Functions Allusers Edt

R Registiation

Advanced features Uoc._get_message_profie local_uocgetmessageprofie Functions Allusers Edt

> User

, g“ s uoc_get_recent_notfications local_uocgetrecentnotifications Functions Al users Edit
ourses

» Grades Uoc_get_unread_notifications local_uocgetunreadnotiications Functions Allusers Edt

» Location

o uoc._get_user_calendar_events local_uocgetusercalendarevents Functions Allusers Edit
anguage

~ Plugins Uoc._get user_unread_messages local_uocgetuserunreadmessages Functions Allusers Edit

[B1Plugins overview

¥ Actiity modules uoc_update_message_profile local_uocupdatemessageprofile Functions Alusers Edit
» Blocks
» Message outputs Custom services

Un cop haguem configurat el token per aquells usuaris que volguem que tingui els serveis

ja els tindrem disponibles per a tercers.

10.2 Utilitzacié dels serveis web

Per tal de poder provar els serveis web hem generat un client d'exemple per cada servei
web que es pot provar des del mateix servidor.

Aquest client I'hem configurat amb uns parametres per defecte i amb dades ja existents a
moodle.

L'accés al client es pot fer a través de la url segiient:

http://mymoodlesite/local/nomdelservei/client/client.php

1 el resultat el podreu visualitzar en el mateix navegador.
Pel que fa a l'aplicaci6 de tercers per tal de poder fer una crida necessitem fer el segiient
1. Obtenir el token per a 'usuari concret i servei concret

http://mymoodlesite/moodle22/login/token.php?username=admin&password=passwor

d&service=myW SshortName

2. Fer la crida al servei web 1 recollir la sortida:

http://mymoodlesite/moodle22webservice/xmirpc/server.php?wstoken= token;
/ICreacié del client XMLRPC

uri = URl.create(serverurl);

XMLRPCClient client = new XMLRPCClient(uri);

parametres = new ArrayList();

resultat = (Object[])client.call(funcio,parametres);



10.3 Imatges del resultat de les crides als serveis web

Crida al servei web uoc_get user calendar events()

- A
dle22/local/uoc lient/client.php

1112PICAM11: Qu 11 Creating a web ser i1 Moodle 2.2 for Mac 1) WEBSERVICES 111 PLUGINS @ PHPmyAdmin 111 TOKENS

Array

[id) => 3

[name] => Entrega PAC3

[description] => Entrega PAC3 del PFC
[format] => 1

[userid] => 2

[eventype] => Entrega

[startdate)] => 201212271500

[endate] => 201212271500

Crida al servei uoc_get user unread messages()

L [e ] © localhost:8888/ dle22/local /uocgetuserunreadi [client/client.php

1112PICAM11: Qu 111 Creating a web ser 111 Moodle 2.2 for Ma 11 WEBSERVICES 111 PLUGINS @ PHPmyAdmin 111 TOKENS
Array
{ (0] => Array

(
[message_read_id] =>
[subject] => New message from - Alumne
[smallmessage] => Gracies passaré dema cap alla les 10h
[fullmessage] => Gricies passaré demd cap allid les 10h

This is a copy of a message sent to you at "Moodle 2.2". Go to http://192.168.0.12:8888/moodle22/message/index.php?user=3&id=2 to reply.
[timecreated] => 1325692463
[useridfrom] => 2
[useridto] => 3
[contexturl] =>
[contexturlname] =>

)

[1) => Array
(
[message_read_id] =>
[subject] => New message from - Professor -
[smallmessage] => Pots venir a a la revisié al meu despatx demad al mati.
[fullmessage] => Pots venir a a la revisié al meu despatx demd al mati.

This is a copy of a message sent to you at "Moodle 2.2". Go to http://192.168.0.12:8888/moodle22/message/index.php?user=3&id=2 to reply.
[timecreated] => 1325692265
[useridfrom] => 2
[useridto] => 3
[contexturl] =>
[contexturlname] =>
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